Canon Plug-in Module CS-U 3.8
for CanoScan N650U/N656U/N1220U Color Image Scanner
User's Guide
How to Make Best Use of the Manuals

When you open the box

- **Printed Manual**
  CanoScan N650U/N656U/N1220U
  Getting Started
  Describes operating procedure from set up and software installation to scanning and confirmation of operation. Please read before using the scanner for the first time.

After reading this guide and scanner is set up and ready for use...

- **Electronic Manual**
  Canon Plug-in Module CS-U
  User’s Guide
  Detailed information on how to use Canon Plug-in Module CS-U.

- **Electronic Manual**
  CanoScan Toolbox CS
  User’s Guide
  Detailed information on how to use CanoScan Toolbox CS.

After you have read this book and mastered the use of Canon Plug-in Module CS-U and CanoScan Toolbox CS...

- **Electronic Manuals**
  Manual for Each Application Software
  Tells you how to use ArcSoft PhotoStudio 2000, ArcSoft PhotoBase and Caere Omni Page SE.

When using the accompanying application software.
How to Use this Guide

This guide explains the operating procedures for Canon Plug-in Module CS-U (hereafter referred to as Plug-in Module CS-U), the Macintosh driver (plug-in software) used with Canon image scanners. A plug-in is not an independent software program; it must be used within a plug-in compliant application, such as CanoScan Toolbox CS or ArcSoft PhotoStudio 2000, to expand the capabilities of that program. Adding scanning capabilities to your computer is as easy as putting in a plug. Simply copy the Plug-in Module CS-U files to your computer. Please read this guide to perform the installation procedures and scan. Store this manual in a handy location for future reference.

Where to Look

Quick Start Instructions  ➔ p. 10
The Quick Start Instructions provide a brief summary of commands and procedures that will assist in using Plug-in Module CS-U immediately.

Scanning Preparations (Required Reading)  ➔ p. 13
All users should read this section. This section describes the procedures and settings required before scanning, including positioning the original and selecting the output device, resolution, magnification and scanning mode.

Scanning (Required Reading)  ➔ p. 29
All users should read this section to learn the procedures for scanning and saving images.

Adjusting Scanned Images  ➔ p. 35
Read this section for details about how to adjust image brightness, color balance and other attributes. You can read this section as required.

Appendices
Read this section for troubleshooting tips, glossary terms and the index.

About the Conventions Used in this Guide

The following conventions are used in this guide to draw your attention to important information.

Caution:
This symbol is used to highlight procedural precautions and limitations. Always read these topics to avoid errors.

Hint:
This symbol is used to present helpful hints and supplemental information. Reading these topics is recommended to enhance your enjoyment of Plug-in Module CS-U.
# Table of Contents

How to Make Best Use of the Manuals ............................................................... 2  
How to Use this Guide ...................................................................................... 3  
Table of Contents ............................................................................................. 4  
Installing Plug-in Module CS-U ....................................................................... 6  
Control Panel Features .................................................................................... 7  
Scanning Procedures ....................................................................................... 8  
Plug-in Module CS-U Special Features ............................................................ 9  

## Quick Start Instructions ............................................................................. 10

### STEP 1

**Scanning Preparations** ............................................................................. 13  
Displaying the Plug-in Module CS-U Control Panel ....................................... 14  
Positioning Originals ..................................................................................... 16  
Previewing ...................................................................................................... 17  
Selecting the Output Device ......................................................................... 18  
Setting the Resolution and Magnification ....................................................... 19  
Setting the Scan Mode ................................................................................... 21  
Verifying the Image before Scanning ............................................................... 23  
Rotating the Image ......................................................................................... 24  
Setting Preferences ....................................................................................... 25  
  - Output Device ......................................................................................... 25  
  - Aspect Ratio ......................................................................................... 25  
  - Unit ....................................................................................................... 26  
  - Preview Window ..................................................................................... 26  
  - Calibration ............................................................................................. 27  
  - Reset Default Settings .......................................................................... 27  
  - Close Plug-in After Scan ....................................................................... 27

### STEP 2

**Scanning** ................................................................................................ 29  
Setting the Scan Area ................................................................................... 30  
Zooming ........................................................................................................ 31  
Scanning ......................................................................................................... 33  
Saving Scanned Images ................................................................................ 34
STEP 3

Adjusting Scanned Images .......................................................... 35
Tone Adjustment .............................................................................. 36
Histogram Settings ........................................................................... 37
Tone Curve Settings ......................................................................... 40
Brightness and Contrast Settings ..................................................... 43
Adjusting the Color Balance ............................................................ 45
Gamma Value Settings ....................................................................... 46
Adjusting the Threshold Value .......................................................... 48
Auto Tone Correction ...................................................................... 49
Unsharp Mask .................................................................................. 50
Descreen .......................................................................................... 51
Saving/Recalling Settings ................................................................. 52
Scanning Techniques ....................................................................... 54

Appendices .................................................................................... 55
Troubleshooting .............................................................................. 56
Error Messages ............................................................................... 58
Glossary ......................................................................................... 59
Index ............................................................................................. 64
Canon Customer Support Help Desk ............................................. 66
Installing Plug-in Module CS-U

Please install Plug-in Module CS-U with the other application programs according to the instructions in the “1. Installing the Software” section of “Chapter 3, Using the Macintosh Platform,” of the Getting Started guide supplied with the scanner.

Operating Environment

Hardware
• Power Macintosh or iMac with built-in USB ports (performance on Macintosh compatibles is not guaranteed)

Main Memory
• 32 MB or more (64 MB or more recommended)

Application Software
• CanoScan Toolbox CS
• ArcSoft PhotoStudio 2000
• Other plug-in compatible application programs

Display
• 256 colors or more (32,000 colors or more recommended; black & white or 4-tone monochrome monitors are not supported)

System Software
• Mac OS 8.5 or higher (First-generation, Bondi blue iMacs may require a system upgrade and an update to the system and firmware.*)

* For information about upgrades and updating for iMacs, refer to the Troubleshooting menu on the CanoScan Setup Utility CD-ROM. Look for the “Scanner won’t work on an iMac” item in the topic entitled “Problems with the Scanner.”

Caution
• The ColorSync™ Profiles file is installed along with Plug-in Module CS-U. ColorSync™ Ver. 2.0 or higher is required to use these profiles with the automatic color matching system (**p. 49**).
• The following display profile files are available: CANON gamma 1.5 monitor, CANON gamma 1.8 monitor and CANON gamma 2.1 monitor. If you wish to adjust the color balance of the display, double-click [ColorSync™] in your Macintosh’s Control Panels folder and select one of these display profiles.
Control Panel Features

When you need more information about a control panel button or menu, refer to the illustration below and go to the referenced page number for more details.

- The illustration may differ slightly from the version of Plug-in Module CS-U provided in your package.

<table>
<thead>
<tr>
<th>Button/Menu</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select [Load] from the [Setting File] menu.</td>
<td></td>
</tr>
<tr>
<td>Close Box</td>
<td>p. 14</td>
</tr>
<tr>
<td>Scan Mode</td>
<td>p. 21</td>
</tr>
<tr>
<td>Output Device</td>
<td>p. 18</td>
</tr>
<tr>
<td>Resolution</td>
<td>pp. 19-20</td>
</tr>
<tr>
<td>Magnification</td>
<td>pp. 19-20</td>
</tr>
<tr>
<td>Image Size</td>
<td>pp. 19-20</td>
</tr>
<tr>
<td>Required/Free memory</td>
<td>p. 21</td>
</tr>
<tr>
<td>Zoom In Button</td>
<td>p. 31</td>
</tr>
<tr>
<td>Zoom Out Button</td>
<td>p. 32</td>
</tr>
<tr>
<td>Tone Adjustment Button</td>
<td>pp. 36-48</td>
</tr>
<tr>
<td>Auto Tone Adjustment Button</td>
<td>p. 36</td>
</tr>
<tr>
<td>RGB values</td>
<td>p. 14</td>
</tr>
</tbody>
</table>

**Hint**

In this guide, menu items are marked in the following manner:

Select [Load] from the [Setting File] menu.
Scanning Procedures

Follow these procedures to use Plug-in Module CS-U.

Is Plug-in Module CS-U installed?

YES

NO

Refer to the scanner's Getting Started guide to install it.

Is the scanner attached?

YES

NO

Refer to the scanner's Getting Started guide to attach it.

STEP 1

Prepare for Scanning → p. 13
- Position the Original  p. 16
- Preview  p. 17
- Select the Output Device  p. 18
- Set the Resolution and Magnification  p. 19
- Set the Scan Mode  p. 21

Verify the Image before Scanning (Browser Window) → p. 23

Are the Brightness and Color Satisfactory?

YES

NO

STEP 2

Scan → p. 29
- Set the Scan Area  p. 30
- Zoom  p. 31
- Scan  p. 33
- Save Scanned Images  p. 34

STEP 3

Adjust and Edit Scanned Images → p. 35
- Histogram  p. 37
- Tone Curve  p. 40
- Brightness and Contrast  p. 43
- Color Balance  p. 45
- Gamma Value  p. 46
- Threshold Value  p. 48
- Auto Tone (ColorSync™)  p. 49
- Unsharp Mask  p. 50
- Descreen  p. 51

If the current brightness and color pose no problem, there is no need to adjust these settings.
Plug-in Module CS-U Special Features

• **See the Results of Adjustments Immediately (Dynamic Preview)**
  Once in preview mode, the results of adjustments to scan mode settings and colors are promptly reflected in the preview image. Highly detailed adjustments can be performed easily because you can see the results of your changes as they are executed.

• **ColorSync™ (Ver 2.0 +) Compatible for Auto Tone Correction**
  Compatible with the Mac OS 8.5 ColorSync™ (Ver 2.0 +) color management software. This function automatically matches the color profiles of various devices, such as scanners, color displays and color printers, for optimal color reproduction.

• **Browser Function Permits Confirmation of the Real Image Before Scanning**
  The Browser function lets you check the image to be scanned in detail before commencing the scan. This function presents a much higher quality image than the preview function.

• **Histogram Function Realizes Beautiful Contrast**
  Simple operation allows you to achieve beautiful contrast with half-tone gradations.

• **Gamma Curve Adjusts Image Brightness**
  The Gamma Curve feature provides four methods you can use to refine in detail the level of image brightness until you are satisfied with the results.

• **Works within Image Processing Software for Easy Image Editing**
  Plug-in Module CS-U can be used to extend the functions of plug-in compatible image processing application programs.
Quick Start Instructions

Follow the procedures below to start scanning immediately. If you require more information at any stage, read the pages referenced at each step.

Install Plug-in Module CS-U
This step is not required if you have already installed Plug-in Module CS-U following the instructions in the Getting Started guide.

1. Place the CanoScan Setup Utility CD-ROM into the computer's CD-ROM drive. The CanoScan Setup Utility will start automatically. (If it doesn't, double click the [CD-ROM] icon, followed by the [setup] icon.)
2. Click [Install the Software] to install Plug-in Module CS-U and the other application programs.

Start Plug-in Module CS-U ➔ p. 14

1. Start ArcSoft PhotoStudio 2000 or other plug-in compatible application.
2. Open the [File] menu, select [Acquire] and [CanonPI CS-U 3.8.0...].

Position materials for scanning and preview them. ➔ p. 16

1. Position an item on the document glass (platen).
2. Click the Preview button.
   • The entire scanable area of the document glass will be previewed and displayed in the preview window.
Set the Scan Mode, Output Device, Resolution and Magnification → pp. 18-22

- Scanning mode determines how the image is scanned (p. 21).
- Output device setting optimizes the images for particular uses (p. 18).
- Resolution determines the amount of detail in the scanned image (p. 19).
- Magnification determines the amount of enlargement or reduction of the output image display (p. 19).

Verify Image Quality with the Browser Function before Scanning → p. 23

1. Click on the [Browser] button.
   • The selection frame will appear.
2. Move the selection frame to specify the area of the image you want verified and click the mouse button.
   • Plug-in Module CS-U will read the image and display the browser image.
3. After you have examined the browser image, click the mouse anywhere.

Specify the Area of the Image to be Scanned → p. 30

Select the area to be scanned by clicking and dragging the mouse pointer over the image.
• You may find it convenient to use the zoom feature to select small areas or to select specific scan areas with precision (p. 31).
Scan the Image  ➔ p. 33

Click on the [Scan] button.

• Plug-in Module CS-U will scan the image.

• When the scan is complete, the Plug-in Module CS-U control panel will close and the scanned image will appear in the ArcSoft PhotoStudio 2000 or other plug-in compatible application window as an “Untitled” file.

Save the Scanned Image  ➔ p. 34

Save the image with ArcSoft PhotoStudio 2000 or other plug-in compatible application, specifying a folder and file name.
Scanning Preparations

Step 1 presents the essential preparations for scanning.
The following procedures are explained on the indicated pages.
Displaying the Plug-in Module CS-U Control Panel

The Plug-in Module CS-U control panel is used to perform scans. Plug-in Module CS-U can be opened from CanoScan Toolbox CS or ArcSoft PhotoStudio 2000 and other plug-in compatible application programs. To quit Plug-in Module CS-U, click on the close box at the top left of the control panel.

Adjusts the settings for the scanning job such as the scan mode, output device, resolution and magnification.

**Close Box**
Quits Plug-in Module CS-U.

**Menu Bar**
Click on any menu item to display more options in a pull-down menu.

**RGB Values**
Displays the R, G, and B values at the current cursor position (pre-adjusted value/post-adjusted value)

**Buttons**
Click the appropriate button to zoom, rotate or browse the image or correct colors, adjust the histogram or start the preview or scan.

The image size and disk size that were specified in the preview window are automatically displayed here.

**Preview Window**
Displays the image in preview mode.
Operating Procedures

The following provides an example of scanning from within ArcSoft PhotoStudio 2000.

1. Verify that the scanner is attached to your computer and that the power is on.
   Read the *Getting Started* guide for instructions on how to connect the scanner.


   Open the [File] menu, select [Acquire] and [CanonPI CS-U 3.8.0...].

The Plug-in Module CS-U control panel will display.

---

Caution

- Plug-in Module CS-U is not a stand-alone application program. It must be started from a plug-in compatible application program, such as CanoScan Toolbox CS or ArcSoft PhotoStudio 2000.
- The size of the Plug-in Module CS-U control panel will vary according to the resolution of the computer display.
- The size of the control panel can be adjusted with the [Preview Window...] option in the [Preferences] menu (*p. 26*).
Positioning Originals

Place the original you intend to scan on the scanner's document glass (platen).

Procedures

1. **Place the original on the scanner's document glass.**
   Open the cover and set the original face down on the scanner’s document glass with the top edge at the front of the scanner. Align the original’s corner with the alignment mark.

2. **Close the cover carefully so the original does not shift out of position.**

**Caution**
- Be careful not to dirty the document glass when placing items on it.
- If an original has distinct horizontal or vertical lines, you should try to position it on the document glass as squarely as possible to have the lines appear straight.
- The maximum scanable size is the area of the entire document glass.
- Straighten out curls or folds in originals before placing them on the document glass.
**Previewing**

The preview scan is a trial scan performed before the final scan that encompasses the entire scanable area of the document glass. The preview image is shown in the preview window. Use this image to specify a scan area and adjust the scan settings for the image.

**Operating Procedures**

- Click on the [Preview] button.
  - The image will be scanned and appear in the preview window.

**Hint**

- To change the size of the preview window, use the [Window Size] settings in the Preview Window Settings dialog (p. 26).

**Caution**

- The Dynamic Preview function enables changes to settings, such as the scan mode and brightness, to be immediately reflected in the preview image.
- Nevertheless, the preview image provides only an approximation of the scan and the final results may differ to some degree from it.
- If the color balance of the preview image is markedly different from the original or color appears in portions of the image that should be white, calibrate the scanner by selecting [Preferences] and [Calibration] (p. 27). Calibrating the scanner sets the correct white balance.
Use the following procedures to select the output device (printer, etc.) for the scanned image. Select the device that corresponds best to your output device and use of the image.

**Operating Procedures**

Click the arrow on the [Output Device] section of the control panel and select a device from the pop-up menu.

---

**Caution**

- You can set the device categories in the pop-up menu in advance. You can also add new devices to the pop-up menu. See *Setting Preferences* (p. 25).
Setting the Resolution and Magnification

The magnification of an image can be changed before scanning to accommodate reproductions that are larger or smaller than the original. The settings can be changed in increments of 1%.

Changing the magnification setting causes the resolution display on the control panel to change correspondingly. This resolution setting is referred to as the “scanning resolution.”

Output Device Resolution = 720 dpi, Magnification = 100%

Hint

Magnification and Resolution

Why does the image size change with the magnification? Let us answer this with an example using a “BJ (720 dpi)” output device. If you were to scan an image with this device setting and set the magnification factor to 50%, the scanning resolution will automatically change to 360 dpi. At this setting, the image will be scanned at a resolution of 360 dpi and the output device will convert this to 720 dpi, shrinking the size of the output in the process because it will only have half the data with which to fill the space.
To Set the Magnification Factor

Set the desired magnification factor on the control panel.

**Hint**

The **Relationship Between Data Volume and Scanning Resolution**

The higher the magnification and scanning resolution settings, the greater the file size of scanned images. There are certain inconveniences associated with large data volumes, such as longer processing times and the risk of running out of memory resources. You are advised against setting the resolution higher than necessary. For example, if you scan an A4 (21.0 x 29.7 cm (8.3 x 11.7 in.)) size image in the color mode, the amount of data varies according to the resolution.

* These numbers are approximate and may differ from actual scan results.
Setting the Scan Mode

When an image is scanned, it is read as a collection of “dots.” The scan mode that is selected determines how each of these dots is represented in the output. The following four scan modes are available.

**Black and White**
Expresses images in two colors only: black or white. A dot is expressed as either black or white according to its brightness level and the value set as the threshold value, which can be freely set. Select this mode to output to a monochrome printer.

**Grayscale**
Expresses images in 256 shades of gray. Select this mode to scan black and white photographs or create monochrome images from color images.

**Color (Documents)**
By scanning more slowly than the Color (Photos) mode, this mode reproduces fine text or lines in greater detail. Select this mode to scan color documents with fine print or graphics. Scanning in this mode takes approximately twice as long as in the Color (Photos) mode.

**Color (Photos)**
Expresses each color channel (RGB) in 256 shades (8 bit). Select this mode to scan standard color photographs.

**Hint**
Scanning the same image in the four different scan modes produces different file sizes. By size, black and white mode requires the least disk space, followed in order by the grayscale and the color modes. Before scanning, check the data volume indicated on the control panel.

The numerator indicates the amount of disk space required for the scanned image while the denominator indicates the amount of disk space available. When the required space exceeds the available space, the scan button is unavailable.
Operating Procedures

1. Click the arrow beside Scan Mode.

2. Select a scan mode from the pop-up menu.

Selecting the box opens the pop-up menu.
Verifying the Image before Scanning

Before initiating the final scan, it is advisable to check the intended results with the Browser function. The image in the browser window is more accurate than the one in the preview window, allowing you to verify the results more precisely before scanning.

To Verify the Image

1. Set the magnification and scan mode to the appropriate settings.

2. Click on the [Browser] button.
   - The selection frame will appear in the preview window to enable a portion of the image to be selected.
   - The size and shape of the selection frame cannot be changed because it is automatically determined by the scanning resolution.

3. Move the pointer in the selection frame inside the preview window.
   - The mouse cursor will change to a “+” sign shape.

4. Move the Selection Frame to the desired position with the mouse cursor.
   - Moving the mouse will move the Selection Frame.

5. Click the mouse button when the selection frame is in the correct position.
   - The image will be scanned and the browser image displayed in the middle of the monitor.

6. Once you have examined the browser image, click the mouse button again to close the browser window.
   - The browser window will close.
   - It does not matter where the mouse cursor is positioned to close the browser window.
Rotating the Image

You can rotate the image in the preview window clockwise to the right or counterclockwise to the left in increments of 90 or 180 degrees. To rotate the image, click the appropriate button.

**Caution**
- If you rotate the image in the preview area, the scanned image will also rotate.

**Operating Procedures**

Use these buttons to rotate the image:

- To rotate the image counterclockwise 90 degrees
- To rotate the image clockwise 180 degrees
- To rotate the image clockwise 90 degrees
Setting Preferences

The Preference settings determine how Plug-in Module CS-U operates for the following options: output device (printer, files), scan area setting method, size display units, preview window size, and close plug-in after scan. You can change these options at any time or restore the factory default settings. To change any of these options, use the Preferences menu.

Output Device

Adds new output devices or file formats to the pop-up menu in the control panel. Devices are displayed by name. Resolution and other settings can be changed for the devices or the devices can be removed.

**Hint**

- The preset devices cannot be edited or deleted.

Aspect Ratio

To set the size of the area to be scanned, drag the mouse to size the selection frame in the preview window. The area inside the borders of the selection frame will be scanned.

When the [Independent] setting is selected, the selection frame can be freely resized and reshaped by dragging it.

When the [Constrained] setting is selected, choose a paper size in the [Mode] option. The selection frame will have a fixed aspect ratio (height to width ratio) when it is resized in the preview window.
**Unit**
Specifies the units that define the size of the scanned image.

**Unit Settings Dialog**

- **Units**:
  - Pixels (px)
  - Inches (in)
  - Millimeters (mm)
  - Centimeters (cm)

The units displayed in this section of the control panel will change.

**Preview Window**
You can size the preview window and set its resolution. Enter a large value for a large preview window size. You can also use this feature to set the auto preview and preview cache options.

**Preview Window Settings Dialog**

- **Resolution**: 20 dpi
- **Width X Height**: 170 x 233 px
- **Memory for execution**: 399 KB
- **Memory required to save the file**: 154 KB
- **Preview setting**:
  - Automatically perform a preview
  - Save preview image
  - None

Allows you to enter values and change settings for the preview window options.

The maximum values are determined by the type of monitor you are using.

Click the appropriate radio button for the function you want to switch on (Automatically perform a preview, Save preview image and None). Only one button can be selected.

**Caution**
- Changing the preview window size will cause the image previously displayed in the preview window to disappear.

**Hint**
- If the “Save preview image” option is selected, the last preview image will appear in the preview window when Plug-in Module CS-U is launched again after quitting once. This reduces the steps required to rescan the same image repeatedly.
**Calibration**

Adjusts the white balance to the correct value so that all the colors are scanned correctly. Calibration takes approximately 1 minute. If the color balance of a scanned image is off-balance, select this option to calibrate the scanner input.

**Reset Default Settings**

Returns the preference settings and all other settings to the factory default settings. The tables list the major default settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scan Mode</strong></td>
<td>Color (Photos)</td>
</tr>
<tr>
<td><strong>Magnification</strong></td>
<td>100%</td>
</tr>
<tr>
<td><strong>Unit</strong></td>
<td>Pixels</td>
</tr>
<tr>
<td><strong>Basic Resolution</strong></td>
<td>72 dpi</td>
</tr>
<tr>
<td><strong>Control Panel Position</strong></td>
<td>Center</td>
</tr>
<tr>
<td><strong>Image</strong></td>
<td>Standard</td>
</tr>
<tr>
<td><strong>Unsharp Mask</strong></td>
<td>Off</td>
</tr>
<tr>
<td><strong>Descreen</strong></td>
<td>Off</td>
</tr>
</tbody>
</table>

**Close Plug-in After Scan**

This setting determines whether or not Plug-in Module CS-U closes automatically after completion of the scanning job. After you install Plug-in Module CS-U, this setting is set to on (Plug-in Module CS-U closes at completion of scanning). To turn this feature off, open the [Preferences] menu and select [Close Plug-in After Scan]. This feature is switched off when you don’t see it marked with a check mark. To switch the feature on, click it again to show the check mark.
Operating Procedures

1. Open the [Preferences] menu in the control panel.

   Preferences
   - Output Device...
   - Aspect Ratio...
   - Unit...
   - Preview Window...
   - Calibration
   - Reset Default Settings...
   - Close Plug-in After Scan

2. Select the desired option from the pull-down menu.
   - Selecting any one of the Output Device, Aspect Ratio, Unit or Preview Window options displays the respective dialog. Choose the desired value in the dialog and select [OK] to change the setting.
   - A confirmation dialog will display if Reset Default Settings is selected. The settings will be reset if [OK] is selected in that dialog.
Step 2 presents the procedures for conducting the final scan, saving the scanned image in a file and editing image files. Follow the procedures below to perform the final scan.

- Setting the Scan Area → p. 30
- Zooming → p. 31
- Scanning → p. 33
- Saving Scanned Images → p. 34
Setting the Scan Area

Using the image in the preview window, you can define the actual area to be scanned.

Operating Procedures

1. Position the pointer in the preview window.
   The [+] symbol marks the current position of the pointer.

2. Click and drag the mouse in the direction you want to define on the image as a frame.
   The selected area is enclosed in a dotted frame. The area enclosed in this dotted frame is the area that will actually be scanned.

   • You may drag the frame in any direction.
   • Clicking the mouse button outside the selection frame causes the selected area to be deselected.
   • Moving the mouse cursor within the selection frame changes it to an omni-directional arrow [ ]. Dragging the cursor in this state will cause the selection frame to move without changing its shape.
   • Placing the mouse cursor over the dotted line of the selection frame causes the cursor to change into one of four shapes [ ] [ ] [ ] [ ]. Dragging the selection frame with the mouse cursor changes its shape.
   • Double-clicking the mouse button anywhere in the preview window selects the entire image.

Hint

• To specify small areas with precision, it is convenient to expand the preview display with the Zoom In button. See Zooming (P. 31).
Zooming

You can specify a selected area of the image for enlargement with the zoom features. You can use the zoom function to select an area with high precision, or to select small areas for scanning.

Procedures to Zoom In

Select the area you want to enlarge with the zoom function.

See Setting the Scan Area (p. 30).
STEP 2

2 Click on the Zoom In button.
The selected area will be displayed in expanded form.
If you want to enlarge the image again, reduce the size of the area selected with the frame and click the Zoom In button again.

3 Click the Zoom Out button to restore the view prior to zooming.

Hint
- The image cannot be zoomed unless an area is selected.
- The selection can be zoomed up to six times consecutively. If the selected area is too small, the Zoom In button will be disabled and the selection cannot be zoomed.
Scanning

Once you have set the magnification and scan mode, you may proceed with the scan. Once the scan is complete, Plug-in Module CS-U automatically closes and returns to the application software, such as CanoScan Toolbox CS or ArcSoft PhotoStudio 2000, if the [Close Plug-in After Scan] setting is on. The following provides an example of scanning from within ArcSoft PhotoStudio 2000.

To Initiate the Scan

1. Specify the Scan Area.
   See Setting the Scan Area (p. 30).

2. Click on the [Scan] button.

   - The scan will start.
   - If a check mark is present in the [Close Plug-in After Scan] option in the [Preferences] menu, Plug-in Module CS-U will automatically quit when the scan finishes.

   **Hint**
   - The scan button cannot be clicked if the scan area is set too small (less than 64x64 pixels) or not specified.
   - The scan cannot be performed if the required memory is larger than the free memory.
Saving Scanned Images

Follow this procedure to save a scanned image with the parent software application. The example below shows how to save a scanned image with ArcSoft PhotoStudio 2000. See the ArcSoft PhotoStudio 2000 User’s Guide.

Operating Procedures

After an image is scanned, the image is displayed as “Untitled.” When you save the image you can give the file a name and select the folder where it is to be stored.

1. Open the [File] menu and select [Save]. The Save dialog will open.

2. Select the folder you want to use for the file.

3. Enter a name for the file and click the [Save] button.
Adjusting Scanned Images

Scanned images may be corrected for brightness and color tone or edited in a variety of ways. The potential adjustments vary with the scan mode utilized in the preview. Adjustments to the scanned image may be made after the image is previewed.

Grayscale, Color (Photos) and Color (Documents):
- Tone Adjustment  ➔ p. 36
- Histogram Settings  ➔ p. 37
- Tone Curve Settings  ➔ p. 40
- Brightness and Contrast Settings  ➔ p. 43
- Adjusting the Color Balance  ➔ p. 45
- Gamma Value Settings  ➔ p. 46

Black & White:
- Adjusting the Threshold Value  ➔ p. 48

Color (Photos) and Color (Documents):
- Auto Tone Correction  ➔ p. 49
- Unsharp Mask  ➔ p. 50
- Descreen  ➔ p. 51
- Saving/Recalling Settings  ➔ p. 52
- Scanning Techniques  ➔ p. 54
Tone Adjustment

Use Tone Adjustment to enhance the brightness or color of the image in the preview area. Open the [Image] menu and select [Tone Adjustment], or click the [Tone Adjustment] button, to open the Tone Adjustment dialog so you can enhance the preview image. You can also click the [Auto Tone Adjustment] button so the histogram highlights and shadows are adjusted for you automatically to the optimum settings.

Caution

• Adjustments cannot be made when the ColorSync option is selected (p. 49).

Tone Adjustment Dialog

The Tone Adjustment dialog contains tabs for the following features: histogram, tone curve, brightness/contrast, color balance, and gamma. If black and white has been selected as the scan mode, the threshold feature also becomes available on the histogram tab. The settings selected in the Tone Adjustment dialog are also reflected in the next preview image. To scan a new item, ensure that you click the [All Reset] button to restore all of the settings to their default values.
Histogram Settings

The data comprising an image contains a variety of brightness settings ranging from shadows to highlights. These settings are represented in Plug-in Module CS-U by values ranging between 0 and 255. The difference in these values determines the image’s contrast. To show how much of the image data falls into each brightness setting, Plug-in Module CS-U contains a histogram feature that shows this data distribution clearly. With the histogram you can adjust the level of shadows and highlights to achieve beautiful tones with the best possible contrast.

Hint
• You can enhance images with the histogram options only when the image has been previewed in the color or grayscale scan modes.
• You cannot enhance the image with the histogram when ColorSync™ is selected.

How to Interpret Histograms
You can select the entire image or specify an area for which a histogram will be generated. The height of the peaks of the histogram is directly related to the volume of data with the corresponding value.

- Distribution of data with a bias toward highlights.
- Distribution of data with a bias toward shadows.
- Distribution of data widely distributed between shadows and highlights.
How to Adjust Histograms

To change the contrast in an image, the distribution of data between shadows and highlights can be adjusted by dragging the shadow and highlight marks at the bottom of the histogram. All of the data lying to the outside (left) of the shadow mark is changed to a zero value and all of the data lying to the outside (right) of the highlight mark is changed to a 255 value. The examples below show adjustments to improve the contrast. Use the [Auto] setting to adjust the histogram for most jobs (p. 39). The graphs below show images adjusted with the Auto setting.

To Adjust a Histogram

1. Specify the area of the image (the entire area to be scanned) for which a histogram will be generated. See Setting the Scan Area (p. 30).
   The histogram will not display correctly if an extremely small area is selected. To select small areas, first expand the display with the Zoom In button. See Zooming (p. 31).

2. Click the histogram tab in the Tone Adjustment dialog to display the histogram options.

3. Click the [Auto] button.
   Although you can freely move the shadow mark and highlight mark to another position, the image can be adjusted easily for optimum effect with the Auto button.
The histogram settings can be adjusted for all channels (Master) or for individual channels (R, G, B). The selectors are displayed to the left of the histogram graph (Master, R, G, B). The Master selection is unavailable if Grayscale has been selected as the scan mode.

**Shadow Mark**
All of the data to the left of this mark is set to the shadow (0) value. Drag the mark to the right or left.

Displays the current level at the shadow mark. Click the up or down arrows in the spinbox to increase or decrease the setting or enter a number directly into the entry box (0~254).

To restore the histogram settings, click this [Reset] button.

To restore all settings to their defaults, click the [All Reset] button.

**Black Eyedropper Button**
Click the Black Eyedropper and click the position in the preview image you want to set to black (0).

**White Eyedropper Button**
Click the White Eyedropper and click the position in the preview image you want to set to white (255).

**Auto Button**
Automatically sets the highlight and shadow settings for optimum effects.

**Highlight Mark**
All of the data to the right of this mark is set to the highlight (255) value. Drag the mark to the right or left.

Displays the current level at the highlight mark. Click the up or down arrows in the spinbox to increase or decrease the setting or enter a number directly into the entry box (1~255).

The Tone Adjustment settings can be saved in a file and reloaded for later use.

Click on the [OK] button.

The preview image will change according to the values specified with the histogram.

**Hint**

- The histogram dialog can also be displayed by selecting [Tone Adjustment] from the [Image] menu.
Tone Curve Settings

You can edit the tone curve directly by changing the shape of the line on the graph. When you change the setting by manipulating the curve, you can perform fine adjustments in the brightness of only the shadows, only the highlights, or both the shadows and highlights.

**Hint**
- You cannot use this feature with the black and white or color scan modes when ColorSync is selected.

**Manipulating the Graph**
The following examples show you how to manipulate the graph to change the settings. When you test these settings yourself, you can see the changes immediately reflected in the preview window or the browser to achieve many interesting effects.

Unadjusted Curve

If you want to brighten the light areas ...

 Drag the mid-tones of the input side (scanned image) into the highlights of the output side (displayed image)

If you want to invert the shadows and highlights ...

 Reverse the starting and end points of the line to invert shadows and highlights.

(If the image is in color, the colors are switched to their complementary colors.)
To Edit the Tone Curve

1. In the Tone Adjustment dialog box, click the tone curve tab.

2. Change the tone curve in any direction to adjust its shape.

You can adjust the setting for each channel: R (red), G (green), B (blue) or M (master). You can adjust each channel independently. (You can adjust RGB only for a color image.)

To create a control point on the line, just click anywhere in the graph. After a control point is displayed in the line, you can click to move it in any direction. As you move it to another location, the value changes. You can set several control points on the tone curve.

3. Click the OK button.

The image in the preview window changes to reflect the new settings.
The Relationship Between the Tone Curve and Image Brightness

Tone curve values fall with a range of 0.01 to 10.00. A value of 1 appears as a straight line in the graph, and if the value is any value other than one, the line on the graph will appear curved. The relationship between the shape of the curve and image brightness is explained below.

**Value = 1**
Input and output and are equal and the curve appears as a straight line, and the input image is displayed on the screen without adjustment.

**Value > 1**
The data bends upward over the range of input values from shadows to highlights, making the adjusted image brighter in the display.

**Value < 1**
The data bends downward over the range of input values from shadows to highlights, making the adjusted image darker in the display.

**CAUTION**
- The tone curve cannot be adjusted manually in one of the color scan modes when ColorSync is selected because the color balance is adjusted automatically.
- The tone curve cannot be adjusted for a black and white image because mid-tones are shown as either black or white. To adjust the brightness of a black and white image, use the *threshold setting* (p. 48).
Brightness and Contrast Settings

You can adjust the image with two slide bars, one for contrast and one for brightness. Use this method to adjust an image before scanning if it is slightly out of focus or too dark.

**Hint**
- You cannot use this feature with the black and white or color scan modes when ColorSync is selected.

### Contrast

Contrast is the difference between the lightest light and the darkest dark in the image. A high contrast setting creates a great difference between light and dark shades, and there is a very sharp distinction between light and dark areas of the image. A low contrast setting creates a small difference between light and dark shades, and the distinction between light and dark areas of the image are not as obvious.

- **Contrast = 128 (Normal)**
- **Contrast = 170**
- **Contrast = 100**

If the image appears slightly out of focus, increase the contrast setting to sharpen the image. If the contrast setting is too high, shadows will blacken and the highlights will wash out.

### Brightness

Brightness is the overall lightness or darkness of an image without changing the contrast. Adjust the brightness setting to change the overall lightness or darkness of the entire image. If the brightness setting is too high, the highlights will wash out, and if too low, the shadows will blacken.

- **Brightness = 128 (Normal)**
- **Brightness = 190**
- **Brightness = 80**
To Adjust the Brightness and Contrast

1. In the Tone Adjustment dialog click the brightness/contrast tab.

2. Adjust the brightness/contrast settings by dragging the slidebars, changing the value with the spinbox buttons, or entering the value directly into the entry box.

   Drag the slidebar left or right to adjust the brightness setting.

   You can also click the up or down arrow in the spinbox to raise or lower its value or enter a number directly into the entry box (-127~+127).

   Drag the slidebar left or right to adjust the Contrast setting.

   The Tone Adjustment settings can be saved in a file and reloaded for later use.

   To restore all the default settings, click this button.

   To restore the brightness/contrast default settings, click this button.

3. Click the [OK] button.

   The settings will be reflected in the image currently displayed in the preview window.
Adjusting the Color Balance

You can enhance color matching by adjusting the color balance of one or all of the three primary colors: red, green and blue (RGB). Use this feature to adjust the color balance when you see an over-abundance of a color in a scanned image.

**Hint**
- You cannot use this feature with the black and white or grayscale scan modes, or with the color scan modes when ColorSync is selected.
- There may be wide differences in the contrast and hue of the display image and printout, depending on the monitor and printer settings. You may have to adjust the settings and execute some test prints to attain the best match between what you see in the image on the display and in the printout.

**Operating Procedure**

1. Click the color balance tab in the Tone Adjustment dialog.

2. Adjust the color balance for each or all of the primary colors: red, green and blue (RGB).

   - Adjust the color by dragging the slide bar left or right.
   - Click the up or down arrow in the spinbox to increase or decrease the number value or enter a number directly into the entry box (-127 to +127).
   - The Tone Adjustment settings can be saved in a file and reloaded for later use.
   - To restore all the default settings, click this button.
   - To restore the color balance default settings, click this button.

3. Click the [OK] button.
Gamma Value Settings

By adjusting the gamma value, you can more closely match brightness of the displayed image to the printed image. Adjust this value if what you see on the screen is very different from your printout.

Hint
• You cannot use this feature with the black and white scan mode, or with the color scan modes when ColorSync is selected.

Matching the Gamma Value to the Display Characteristics
Not all screen displays reproduce color tones in exactly the same way, and this reproduction method is expressed as a gamma value from 1.4 to 2.2 and normally reproduces a slightly dark image.
In order to avoid this and reproduce an image that is faithful to the original, the gamma value must be adjusted in Plug-in Module CS-U. Plug-in Module CS-U can adjust the pre-set screen gamma value of 1.8, but if the screen has a gamma value other than 1.8 then the gamma value for that screen must be set.

Gamma value
Plug-in Module CS-U and the screen display have different gamma values. During a scanning job Plug-in Module CS-U receives the image read from the scanner as input and sends it to the parent application as output. The gamma value in this interval where Plug-in Module CS-U converts input to output is the Plug-in Module CS-U gamma value.
On the other hand, the data received from Plug-in Module CS-U as input is sent to the screen display as output. The gamma value in this interval where the image input from Plug-in Module CS-U is converted to output for the screen display is the screen display gamma value.
Setting the screen display gamma value causes the scanner gamma value to be calibrated automatically as the inverse value. For example, if the screen display gamma value is set for 1.8, then the scanner gamma value is calibrated for 0.56 (the inverse of 1.8).

Hint
• Please read the documents shipped with your display or contact the manufacturer’s customer service department to obtain the correct gamma value for your particular display model.
• If you intend to adjust the color tone with ColorSync™, change the settings in the ColorSync™ control panel (found within the Control Panels folder) (p. 6) and do not manually change the gamma value settings as described in the following pages.
To Change the Gamma Value Settings

1 Click the gamma tab in the Tone Adjustment dialog.

2 Click a pre-set value or the custom option.

3 Click the [OK] button.
   The changes are reflected in the image currently displayed in the preview window.
Adjusting the Threshold Value

When the scan mode is set to black and white, the image brightness can be adjusted. The threshold value setting determines whether a halftone will be expressed as a black or a white data point. The possible threshold values range between 0 and 255. Below a given threshold value, all data is converted to black. Likewise, all data with a value above the threshold is converted to white. Accordingly, higher threshold values produce darker images while lower threshold values result in brighter images.

To Set the Threshold Value

When the scan mode is set to black and white, click the [Tone Adjustment] button or pull down the Image menu and select [Tone Adjustment].

Drag the slidebar left or right to adjust the threshold setting.

Click the up or down arrow to increase or decrease the entry in the text box, or enter the value (0–255) directly from the keyboard.

After adjusting the threshold value, you can save the setting to a file under a file name and load the file again whenever you want to use the setting.

To restore the threshold setting to its default value, click this button.

Click the [OK] button.

The preview image will change to reflect the new settings.
Auto Tone Correction

When the selected scan mode is Color (Documents) or Color (Photos), you have three options for adjusting the color: Standard, ColorSync or None. The default setting is [Standard].

Standard
Use this option if scanned images are to be viewed primarily on the computer display with photo album software. This method adjusts the computer display to reproduce the color balance of the original as closely as possible.

ColorSync
Use this option if the scanned images are to be output to a printer. This method automatically harmonizes the color adjustment functions of scanners, displays and printers for consistent color matching. The printer must also have its ColorSync setting set to On.

None
Use this option if you wish to adjust the color balance manually with Plug-in Module CS-U or another image editing program. This method does not adjust the color balance at all.

Caution
• This function is available only when the scan mode is set to one of the color modes; not to the grayscale or black and white modes.
• The Tone Adjustment menu item, Tone Adjustment button and Auto Tone Adjustment button are disabled when the ColorSync option is selected.
• The previous settings are in effect when Plug-in Module CS-U is started from an application program that does not display the Plug-in Module CS-U control panel.

Hint
• ColorSync™ responds differently to each computer according to the unique conditions affecting it (type of display used, etc.), which may cause differences even between computers of the same make and system version. The tone characteristics of an image scanned with ColorSync™ on one computer, therefore, may change when processed on another computer.

To Set the Auto Tone Correction

Open the [Image] menu and select [Standard], [ColorSync] or [None].

A check mark will appear beside the selected option, which will take effect.
Unsharp Mask

The Unsharp Mask function enhances the outlines of an image. When set to On, this function makes the image outlines appear sharper without changing the brightness, contrast or color balance, giving it a natural look. It is particularly useful for scanning images that are slightly out of focus. The function is on when a check mark appears beside it and off when there is none. The default value is Off.

Caution
- This setting is not available for the black and white scanning mode.
- If Plug-in Module CS-U is started within an application that hides the Plug-in Module CS-U control panel, the previous setting will be maintained.

Operating Procedures

Open the [Image] menu and select [Unsharp Mask].

A check mark will appear beside the Unsharp Mask option in the menu when this function is set to On. To set it to Off, reselect it. The check mark will disappear.

Hint
- Disable the Unsharp Mask function if the moiré effect is still too strong even when the Descreen option is on.
Descreen

Moiré patterns occasionally appear when items printed at high resolutions are scanned. To reduce this phenomenon, scan photographs and other high-resolution prints with the Descreen function enabled. Shut it off to scan lower resolution items, such as newspapers, books and magazine text. The default setting is “off.”

**Caution**
- The Descreen function cannot be switched on for scanning resolutions higher than 601 dpi.
- The previous setting is enabled for the Descreen function when Plug-in Module CS-U is opened by a software application operating in the windowless mode.

**Operating Procedures**

Open the [Image] menu and select [Descreen].

A check mark will appear beside the Descreen option in the menu when this function is set to On. To set it to Off, reselect it. The check mark will disappear.
Saving/Recalling Settings

The scan mode, resolution and preference settings can be saved with a preview image to a settings file and recalled for future processing. The user may freely assign a name to the settings file. It is convenient to save frequently used settings in a file.

**Hint**
- In addition to settings, the settings file may also be used to store preview images. It is useful to save the preview image with the settings to quickly grasp to which image the settings apply.

**To Save Settings in a Settings File**

1. Open the [Setting File] menu and select [Save].

2. Specify the folder where you want to store the file and enter a name for it.

   ![Setting Files Window]

   Insert a check mark by clicking this box to have a copy of the preview image saved with the settings file.

3. Click the [Save] button.
To Recall a Settings File

1. Open the [Setting File] menu and select [Load].

2. Select the folder where the file is stored and click the name of the file you want to load.

3. Click the [Open] button.
   The file you selected opens and the settings stored in the file are enabled for the Tone Adjustment settings.
Scanning Techniques

Matching Scan Resolution to Purpose

Plug-in Module CS-U provides many choices of resolution. The resolution you choose should depend upon your output device, the intended purpose of the image, the type of image and your scanner.

It is generally recommended that you scan at a higher resolution than required for output. This ensures that you obtain the best quality image, which can then be reduced with an image editing program to suit specific purposes.

Different types of images require different scan settings. However, increases in scan resolution have a diminishing return after a certain point. For example, a text image can be scanned at 600 dpi for output to a 600 dpi laser printer, while a color image should be scanned at 180 dpi to be output to a color bubble jet printer (360 dpi). To output a color or grayscale image to a bubble jet printer, use a resolution equal to half the resolution of the printer. Set the resolution to 180 dpi, for example, for output on a 360 dpi printer.

• Scan in black and white mode if you are scanning line art or other items that are black and white with no shades of gray.
• Scan in black and white mode if you are scanning a text image for conversion to editable text.
• Scan in grayscale mode if you are scanning continuous-tone black and white photographs, charcoal drawings or originals with shades of gray.
• Scan in Color (Photos) mode if you are scanning full-color images, such as photographs or illustrations.
• Scan in Color (Documents) mode if you are scanning items that include text or charts at a low resolution. It may take some time to scan in this mode.
• If you are using an OCR (optical character reader) program in black and white mode, you are recommended to select a resolution higher than 300 dpi.
• The minimum scannable height and width will vary with the scanning resolution. At 75 dpi, for example, the minimum selectable height and width in the preview area is 9 pixels (approximately 0.12 inches or 0.30 cm). At 300 dpi, it is 35 pixels (approximately 0.12 inches or 0.30 cm).

Optical and Enhanced Resolutions

Optical resolution refers to the amount of information a scanner can sample per inch. Different varieties of scanner feature different optical resolutions. The maximum optical resolution of the CanoScan N650U/N656U models is 600 dpi for the primary scan (horizontal dimension of the document), and 1200 dpi for the secondary scan (vertical dimension). The CanoScan N1220U optical resolution is 1200 dpi for the primary scan and 2400 dpi for the secondary scan.
Appendices

- Troubleshooting → p. 56
- Error Messages → p. 58
- Glossary → p. 59
- Index → p. 64
- Canon Customer Support Help Desk → p. 66
# Troubleshooting

Please refer to the following information if you encounter a problem using Plug-in Module CS-U. For further details, refer to the Troubleshooting item on the CD-ROM provided with your scanner.

If your problem lies outside the solutions provided below, consult the retail outlet from which you purchased the software or the closest Canon Customer Support Help Desk.

## Hint

- Before you call for assistance, read the Getting Started guide.
- When you contact one of the help desks listed, you will be asked what kind of computer is connected with the scanner. Before you call, make sure you have prepared the information required on the system information page in the Getting Started guide.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The “Can’t use the driver required for a USB device. Search the Internet for a driver?” dialog displays on a system running Mac OS 9 (only applicable to Mac OS 9)</td>
<td>Scanner software has not been installed. Click the [Cancel] button to close the dialog. Detach the scanner, and install the required software from the CanoScan Setup Utility CD-ROM before reattaching the scanner. (<a href="#">Getting Started guide</a>)</td>
</tr>
<tr>
<td>Plug-in Module CS-U does not appear as an option on the menus of a plug-in compatible application program</td>
<td>Plug-in Module CS-U is not correctly installed on your hard disk drive. Reinstall Plug-in Module CS-U. (<a href="#">Getting Started guide</a>)</td>
</tr>
</tbody>
</table>
| The image will not appear even if the Preview button is clicked on the Plug-in Module CS-U control panel | Solution 1: Make sure the original is set on the document glass correctly  
Solution 2: The brightness settings for Plug-in Module CS-U may be set too high. Try lowering the brightness settings. For details about brightness setting, see Brightness and Contrast Settings ([p. 43](#))  
Solution 3: The threshold setting for Plug-in Module CS-U may be set too high. Try lowering the threshold setting. For details about setting the threshold setting, see Adjusting Threshold Value ([p. 48](#)) |
Problem: Scan button cannot be selected

Solution 1: A scan cannot be performed if the scan area is set too small (less than 64 x 64 pixels). Increase the size of the scan area.

Solution 2: A scan cannot be performed unless a scan area is specified. Specify a scan area.

Solution 3: A scan cannot be performed if the required memory is larger than the free memory. Change the resolution (p. 19) or scan area (p. 30) until the required memory is lower.

Problem: The “Insufficient Memory” error message appears when scanning

Solution 1: Select the smallest possible area and rescan.

Solution 2: Lower the resolution and magnification settings for the output device to the lowest possible values (p. 19).

Solution 3: Rescan after closing all the application programs other than the one used to start Plug-in Module CS-U.

Solution 4: Rescan after you have restarted the application program used to start Plug-in Module CS-U.

Solution 5: Quit the application program used to start Plug-in Module CS-U and increase the memory allocated to it. Restart the computer before rescanning. Please refer to the manual for the application program for the correct method for increasing its memory allocation.

Solution 6: Increase the amount of RAM as required.

Problem: The [Image] menu [ColorSync] option cannot be used in Plug-in Module CS-U

Solution: ColorSync is not recognized after Mac OS upgraded to Version 9 after Plug-in Module CS-U was installed onto Mac OS 8.5 or 8.6. Reinstall Plug-in Module CS-U (p. 6).
### Error Messages

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause</th>
<th>Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scanner is not connected. Connect the scanner.</td>
<td>• USB cable not connected correctly.</td>
<td>• Use the USB cable to connect the Macintosh to the scanner properly.</td>
</tr>
<tr>
<td>Scanning unit is locked. Release the lock switch at the base of the scanner and connect the PC to the scanner again.</td>
<td>• The scanning unit lock not released.</td>
<td>• After releasing the lock, temporarily disconnect the USB cable. Reconnect it and restart Plug-in Module CS-U.</td>
</tr>
<tr>
<td>• The scanning unit is out of order.</td>
<td>• Contact your nearest Canon Customer Support Help Desk.</td>
<td></td>
</tr>
<tr>
<td>Sensor type error. Please get a new driver.</td>
<td>• Old version of driver software detected.</td>
<td>• Download and install the latest driver software.</td>
</tr>
<tr>
<td>1) Cannot complete scan command. Insufficient memory (RAM). 2) Memory is insufficient. Increase the memory allocated the application.</td>
<td>• Memory is insufficient for the required volume of the scanned image data.</td>
<td>• Reduce the scan area to the minimum possible scope and lower the resolution and magnification settings for the output device.</td>
</tr>
<tr>
<td>As image size is large, it will take long to complete scanning. Do you want to continue?</td>
<td>• You attempted to scan an image exceeding 100 MB.</td>
<td>• Close all application programs other than the one used to start Plug-in Module CS-U.</td>
</tr>
<tr>
<td>• You attempted to scan an image exceeding 100 MB.</td>
<td>• Increase the memory allocated to the application program used to start Plug-in Module CS-U.</td>
<td></td>
</tr>
<tr>
<td>An error has occurred. Error Code =** Restart the PC.</td>
<td>• Scanner or computer is malfunctioning.</td>
<td>• Click [Cancel] to cancel, or rescan after lowering the scanning resolution or reducing the scanning area.</td>
</tr>
<tr>
<td>• Scanner or computer is malfunctioning.</td>
<td>• Restart the computer. If the same error code displays after restarting the computer, contact the nearest Canon Customer Support Help Desk.</td>
<td></td>
</tr>
</tbody>
</table>
Glossary

**Auto Tone Correction**
A function that uses brightness/contrast and gamma value settings to automatically analyze and adjust images.

**Bits/Bit Numbers**
Each dot of a 1-bit image is assigned either black or white according to the threshold brightness value, resulting in the image being reproduced in just those two colors. Each dot of an 8-bit grayscale image can be assigned any one of 256 tones of gray, ranging from pure white to black. Each dot of a 24-bit color image can be assigned any one of 16.7 million colors since each of its color channels (red, green and blue) can be expressed in 256 distinct color tones (8 bits).

**Black and White**
An image mode used to reproduce images in two tones only: black and white. The brightness level at which a dot is determined to be either black or white is called the threshold value, which can be adjusted. See Threshold Value.

**Black Eyedropper Tool**
Tool used to the select the darkest portion of an image in the preview area. Used with the Histogram function to adjust image brightness. When this tool is clicked on the image, all areas that are darker are set to pure black.

**Brightness**
The intensity of light in a scanned image. Raising an image’s brightness increases its overall brilliance, while decreasing it makes it darker.

**Calibration**
A scanner function that automatically adjusts the scanner’s white balance to true white.

**Color Balance**
The function in that enables you to adjust the blend of colors in a color image. You can adjust the color balance by altering the blend of the red, green and blue color set or the cyan, magenta, yellow and black color set.
Color Channel
Any one of the red, green or blue elements of a color image. Since color images are assigned 8 bits per pixel for each of the red, green and blue channels, each pixel is assigned 24 bits of data. The master channel is the composite of these three channels. In the Histogram and Tone Curve image adjustment functions, each channel can be separately or collectively adjusted.

Color (Documents)
An image mode that reproduces images with the same number of color tones as the Color (Photos) image mode, but scans more slowly to obtain better definition of fine lines and text. See Color (Photos).

Color (Photos)
An image mode that scans an image as red, green and blue (RGB) light and can reproduce each one of these three colors in 256 distinct tones (8 bits). Since \(256 \times 256 \times 256 = \text{approximately } 16.7 \text{ million, this many color tones are possible in this mode.}\)

ColorSync
A color management system for Macintosh computers. Automatically compensates for color differences between scanners, monitors and printers. ColorSync requires that a color profile file be included for your specific monitor or printer.

Contrast
The difference between light and dark areas of a scanned image. Raising the contrast makes individual components of an image stand out more while lowering it softens the image’s overall appearance.

Dot
The basic element used to reproduce images. Images are reproduced as columns and rows of dots. A scanner’s resolution is the measure of the number of dots it can read and reproduce per inch (dpi).

DPI
Dots per inch. An expression of monitor and printer resolution. Measured as the number of dots per horizontal inch on monitors and the number of dots that can be printed by a printer in an inch. See also Pixel, Optical Resolution and Resolution.
Gamma Value
A function for adjusting the overall brightness of an image. A gamma value is the mathematical expression of how brightness data is converted from a scanner (the input) to a monitor or printer (the output). With 1 as the base value, a gamma value less than 1 makes an image darker, while a higher value makes it brighter. The brightness handling characteristics of monitors vary between manufacturers and models. A monitor's gamma value explains the degree to which its output (what you see on the screen) varies from the input value.

Grayscale
An image mode that scans only the brightness data of an image and reproduces the image in white, black and 254 shades of gray (256 tones or 8 bits).

Histogram
A graph indicating the distribution of brightness data in an image. A dot is assigned a brightness value ranging from 0 (shadows) to 255 (highlights). The histogram shows how much image data there is at each brightness value. Adjusting the histogram changes the image contrast.

Image File
Images are expressed as collections of dots with varying color and brightness values that are digitized in particular formats for processing by a computer. At the most basic level, an image file contains bitmap information, which is the color information for each dot in each column and row of an image. The various file formats (TIFF, JPEG, BMP, etc.) use different methods of storing and recalling this information.

JPEG
A file format developed by the Joint Photographic Experts Group. A standard for storing color image data in a compressed format. The file extension is “.jpg.”

Magnification
An expression of the relationship between the scanning resolution and the output resolution stated as a percentage. If the output resolution is set to 720 dpi and the scanning resolution to 360 dpi, then the magnification rate is 50%.
Moiré
The patterns or lines created by overlapping dots in an image. This phenomenon is found when photographs or pictures are scanned from books and magazines at low resolutions. The Descreen function helps to eliminate moiré patterns.

Optical Resolution
An expression of the volume of data per inch (dpi) that can be sampled by a scanner.

Pixel
An abbreviation of picture element, the smallest element on a monitor screen.

Plug-in Software
A program that extends the functionality of an application program. Plug-in Module CS-U is a driver plug-in that adds scanning capabilities to programs such as CanoScan Toolbox CS and PhotoStudio 2000.

Preview Area
Area at the right of the Plug-in Module CS-U window used to display preview images. Clicking the [Preview] button causes the scanner to scan its platen and reproduce the image in the preview area. Please note, however, that preview images do not get downloaded to the application program in use.

Preview Scan
A low-resolution, trial scan of an object. The image shown in the preview area can be used to adjust the scan area, brightness and color balance before initiating the final scan.

Resolution
The density of the dots used to express an image. Image fineness or coarseness is expressed as the number of dots per inch (dpi). See also DPI.

RGB
A color set of red, green and blue: the three primary colors of light. The scanner picks up light reflected off objects with its red, green and blue sensors. Color printers output color using the complements to the RGB color set, which are cyan, magenta, yellow and black (CMYK). Cyan, magenta and yellow are called the three secondary colors.
Scan Mode
Any one of the various methods used to reproduce image data. Scan modes are distinguished by the number of bits used to describe each pixel. Plug-in Module CS-U features the following scan modes.

- **Color (Photos)/Color (Documents):** assigns 8 bits of data for each color channel (RGB) in each pixel. Each pixel is therefore assigned 24 bits.
- **Grayscale:** assigns 8 bits of data to its single color channel. Each pixel is therefore assigned 8 bits.
- **Black and White:** assigns 1 bit of data to each pixel.

Scanning
The process of using a scanner to read image data. Scanned data is sent to the computer as image data.

Shadows
The darkest portions of an image scanned in a color or grayscale image mode.

Threshold Value
The dividing value at which a pixel is determined to be either black or white when the image is reproduced as a black and white image. The higher the threshold, the darker the image. The lower the threshold, the brighter the image.

Tone Curve
A function used to adjust image brightness. The tone curve (or gamma curve) is a graphic representation of the relationship of the input from the scanner to the output to the monitor or printer.

Unsharp Mask
A function that sharpens image outlines. Makes an image appear naturally sharper without changing the brightness, contrast or color balance.

White Eyedropper Tool
Tool used to select the brightest portion of an image in the preview area. Used with the Histogram function to adjust image brightness. When this tool is clicked on the image, all areas that are brighter are set to pure white.
# Index

## A
Alignment mark 16
Application
  Compatible 15
  Stand-alone 15
Aspect ratio 25
Auto button 39
Auto Tone Adjustment button 7, 36
Auto Tone Correction 59

## B
Bits/Bit numbers 59
Black and White 21, 59
Black Eyedropper button 39
Black Eyedropper tool 59
Brightness 43, 59
Brightness/Contrast tab 44
Browser 9, 23
Browser button 7, 11, 23
Buttons 14

## C
Calibration 27, 59
CanoScan Setup Utility CD-ROM 10
Close box 7, 14
Close Plug-in After Scan 27
Color (Documents) 21, 60
Color (Photos) 21, 60
Color balance 45, 59
Color balance tab 45
Color channel 60
ColorSync 6, 9, 49, 60
Contrast 43, 60
Control panel 7, 14

## D
Descreen 51
Disk space
  Available 21
  Required 21
Dot 60
DPI 60
Dynamic preview 9, 17

## F
File size 20
Free memory 7

## G
Gamma tab 47
Gamma value 46, 61
Grayscale 21, 61

## H
Half-tone 9
Highlight mark 39
Highlights 37
Histogram 37, 61
 Histogram tab 38

## I
Image file 61
Image menu 36
Image size 7
Install 6, 10
JPEG 61

## L
Load Settings file 53

## M
Magnification 7, 11, 19, 20, 61
Menu bar 14
Moiré 51, 62

## O
Optical resolution 54, 62
Output device 7, 11, 18, 25, 54

## P
Pixel 62
Plug-in Software 62
Preferences 25
Preview 9, 17
Preview area 62
Preview button 7, 17
Preview mode 9
Preview scan 17, 62
Preview setting 26
Preview window 7, 14, 17, 26
Preview window size 26
<table>
<thead>
<tr>
<th>Required memory</th>
<th>7</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>7, 11, 19, 62</td>
</tr>
<tr>
<td>RGB</td>
<td>14, 45, 62</td>
</tr>
<tr>
<td>RGB values</td>
<td>14</td>
</tr>
<tr>
<td>Rotating the image</td>
<td>24</td>
</tr>
<tr>
<td>Rotation button</td>
<td>7, 24</td>
</tr>
<tr>
<td>Save Scanned image</td>
<td>12, 34</td>
</tr>
<tr>
<td>Save Settings file</td>
<td>52</td>
</tr>
<tr>
<td>Scan</td>
<td>12, 33</td>
</tr>
<tr>
<td>Scan area</td>
<td>11, 30</td>
</tr>
<tr>
<td>Scan button</td>
<td>7, 12, 33</td>
</tr>
<tr>
<td>Scan mode</td>
<td>7, 11, 21, 63</td>
</tr>
<tr>
<td>Scanning</td>
<td>63</td>
</tr>
<tr>
<td>Scanning resolution</td>
<td>19, 54</td>
</tr>
<tr>
<td>Screen gamma value</td>
<td>46</td>
</tr>
<tr>
<td>Settings file</td>
<td>52</td>
</tr>
<tr>
<td>Shadow mark</td>
<td>39</td>
</tr>
<tr>
<td>Shadows</td>
<td>37, 63</td>
</tr>
<tr>
<td>Special features</td>
<td>9</td>
</tr>
<tr>
<td>Start Plug-in Module CS-U</td>
<td>10, 14</td>
</tr>
<tr>
<td>Threshold</td>
<td>48</td>
</tr>
<tr>
<td>Threshold value</td>
<td>48, 63</td>
</tr>
<tr>
<td>Tone Adjustment</td>
<td>36</td>
</tr>
<tr>
<td>Tone Adjustment button</td>
<td>7, 36</td>
</tr>
<tr>
<td>Tone Adjustment dialog</td>
<td>36</td>
</tr>
<tr>
<td>Tone curve</td>
<td>40, 63</td>
</tr>
<tr>
<td>Tone curve tab</td>
<td>41</td>
</tr>
<tr>
<td>Tone curve value</td>
<td>42</td>
</tr>
<tr>
<td>Unit</td>
<td>26</td>
</tr>
<tr>
<td>Unsharp mask</td>
<td>50, 63</td>
</tr>
<tr>
<td>White Eyedropper button</td>
<td>39</td>
</tr>
<tr>
<td>White Eyedropper tool</td>
<td>63</td>
</tr>
<tr>
<td>Zoom In button</td>
<td>7</td>
</tr>
<tr>
<td>Zoom Out button</td>
<td>7</td>
</tr>
<tr>
<td>Zooming</td>
<td>31</td>
</tr>
<tr>
<td>Zoom in</td>
<td>31</td>
</tr>
<tr>
<td>Zoom out</td>
<td>32</td>
</tr>
</tbody>
</table>

No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any language in any form by any means without the prior written permission of Canon Inc.

Canon Inc. makes no warranties for damages resulting from corrupted or lost data due to the operation or malfunction of hardware and software.

While every effort has been made to ensure that the information contained in this guide is accurate and complete, no liability can be accepted for any errors or omissions. Canon Inc. reserves the right to change the specifications of the hardware and software described within this guide at any time without prior notice.

Please take note that international copyright laws prohibit the scanning of copyright-protected materials for any uses other than for personal use.

CanoScan and Canon Plug-in Module are trademarks of Canon Inc.

Macintosh, Power Macintosh, Mac OS and ColorSync are trademarks of Apple Computer, Inc., registered in the U.S. and other countries.
iMac is a trademark of Apple Computer, Inc.
Adobe and Adobe Photoshop are trademarks of Adobe Systems Incorporated.

Other names and products are trademarks or registered trademarks of their respective companies.
Canon Customer Support Help Desk

CANON COMPUTER SYSTEMS, INC.
2995 Redhill Avenue Costa Mesa, CA 92626 U.S.A.
Tel: 1-800 OK CANON
http://www.ccsi.canon.com

CANON (UK) LTD.
Woodhatch, Reigate Surrey RH2 8BF, United Kingdom
For technical support, please contact Canon Helpdesk.
Help Desk:
P.O. Box 431, Wallington, Surrey SM6 0XU
Tel: (08705) 143 723 Fax: (08705) 143 340
For sales enquiries: (0121) 666-6262

CANON FRANCE S.A.
17, quai du Président Paul-Doumer
92414 Courbevoie Cedex, France
Hotline:
Tel: 01 4199 7070

CANON DEUTSCHLAND GmbH
Postfach 528, 47705 Krefeld, Germany
CANON- Hotline-Service
Customer Support: (0 21 51) 349-555
Info-Desk: (0 21 51) 349-566
Mailbox: (0 21 51) 349-577
Telefax: (0 21 51) 349-588

CANON ITALIA S.p.A
Palazzo L, Strada 6, 20089
Milanofiori-Rozzano (MI), Italy
Tel: 02/8248. 1 Fax: 02/8248. 4604
Pronto Canon 02/8249. 2000
http://www.canon.it

CANON OY AB
Kornetintie, 3, 00380 Helsinki, Finland
Tel: 010 544 20 Help Desk: 0600-0-22606
Fax: 010 544 4571

CANON DENMARK
Vasekær 12, DK-2730 Herlev, Denmark
Hotline: 44 88 26 66
http://www.canon.dk

CANON NORGE AS
Hallagerbakken 110, Boks 33, Holmia 1201
Oslo 12, Norway
Tlf: 2262 9321 Fax: 2262 0615

CANON BENELUX NEDERLAND B.V.
Neptunusstraat 1, 2132 JA Hoofddorp, The Netherlands
Tel: 023-5 670 123 Fax: 023-5 670 124
Help Desk: 023-5 681 681

CANON BENELUX BELGIUM N.V./S.A.
Bessenveldstraat 7, 1831 Diegem, Belgium
Tel: 02 7220411 Fax: 02 7213274
Helpdesk: 02 7220404

CANON GmbH
Zetschegasse 11, 1232 Wien, Austria

CANON (SCHWEIZ) A.G.
Industriestrasse 12, CH-8305 Dietlikon Switzerland
Tel: 01/83561 61 Fax: 01/835 68 60
Hotline: 157 30 20

CANON ESPAÑA S.A.
C/Joaquin Costa No 41, 28002 Madrid, Spain
Help Desk: 906. 301255
Tel: 91-5384500 Fax: 91-4117780

CANON AUSTRALIA PTY. LTD.
1 Thomas Holt Drive, North Ryde, Sydney N.S.W. 2113, Australia
Info-Line: (02)9805 2864

CANON NEW ZEALAND LTD.
Fred Thomas Drive, Takapuna
P.O. Box 33-336 Auckland, New Zealand
Info-Line: 0900-522666

CANON HONGKONG CO., LTD.
9/F, The Hong Kong Club Building,
3A Chater Road, Central, Hong Kong
Tel: (852)2739 0802 Fax: (852)2739 6428

CANON SINGAPORE PTE. LTD.
79 Anson Road #09-01/06 Singapore 079906

CANON MARKETING SERVICES PTE. LTD.
2, Alexandra Road, #04-01A
Delta House Singapore 159919
Tel: 65 2735311 Fax: 65 2733317

CANON MARKETING (MALAYSIA) SDN. BHD.
Wisma General Lumber, Block D, Peremba Square
Saujana Resort, Section U2, 40150 Shah Alam
Selangor Darul Ehsan, Malaysia
Tel: 603-744-6000 Fax: 603-745-0505

CANON MARKETING (THAILAND) CO. LTD.
2nd Floor, Indosuez House
152 Wireless Road, Bangkok 10330 Thailand
Tel: 66-2-6514000 Fax: 66-2-6514096

CANON MARKETING (PHILIPPINES) INC.
Marvin Plaza Building, 2153 Don Chino Roces Ave,
Makati City, Metro Manila, Philippines
Tel: 632-812-6047 Fax: 632-812-0067/810-9797

CANON CANADA, INC.
6390 Dixie Road Mississauga, Ontario L5T 1P7, Canada
1-800 OK CANON (652-2666)
http://www.canon.ca

CANON LATIN AMERICA, INC.
6505 Blue Lagoon Drive Suite 325
Miami, Florida 33126, U.S.A.

CANON EUROPA N.V.
P.O. Box 2262, 1180 EG Amstelveen
The Netherlands

CANON INC.
30-2 Shimomaruko 3-chome, Ohta-ku
Tokyo 146-8501, Japan